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1. Introduction

1.1 Purpose
The CY3267 PowerPSoC™ Lighting Evaluation Kit enables designers to evaluate Cypress'
PowerPSoC family of devices and demonstrates their ability to create scalable LED management
solutions. The PowerPSoC devices feature high performance power electronics including 1A, 2 MHz
power FETs, hysteretic controllers, current sense amplifiers, and PrISM™/PWM modulators to
create a complete solution for LED power management. 

Right out of the box, the CY3267 Kit can be used to evaluate PowerPSoC's ability to drive 4 LED
channels (Red, Green, Blue and Amber) at the desired color and brightness output. Refer to the
CY3267 Quick Start Guide for instructions on how to use the kit with the factory installed firmware. 

Chapter 2 of this guide provides a detailed explanation of the factory installed firmware. 

Chapter 3 describes the Intelligent Lighting Control GUI, along with installation instructions. This GUI
can be used to select the desired color coordinates and intensity output when used along with the
RGBA LED Daughter Card included with the kit.

Chapter 4 contains hardware setup information while using the CY3267 Kit to build example
projects. This chapter also contains architectural and layout information of the PowerPSoC Main
Board and the RGBA LED Daughter Card. 

1.2 Kit Contents
■ CY3267 PowerPSoC Main Board
■ LED Daughter Board
■ Wall-wart Power Supply
■ Optical Diffuser
■ Retractable USB Cable

WARNING: HIGH BRIGHTNESS LEDs CAN CAUSE PERMANENT
EYE DAMAGE!
Do not look at the LEDs if they are not covered by the optical diffuser.
The LEDs illuminate at a very high intensity and can cause
permanent eye damage if they are viewed without the optical diffuser.

WARNING: Generally all lab work in power electronics must be done
with extreme care. Caution must be exercised when using power
supplies and/or power related equipment.



6 CY3267 PowerPSoC Lighting Evaluation Kit Guide, Spec. # 001-49266 Rev. **

Introduction

■ Lighting Evaluation Kit CD
❐ Kit Guide and Quick Start Guide (located at CD Drive:\Documents\)
❐ Board Schematics, BOM, and Design Files (located at CD Drive:\Hardware\)
❐ Intelligent Lighting Control GUI Setup (located at CD Drive:\Software\)
❐ PowerPSoC default firmware source code (located at CD Drive:\Firm-

ware\CY3267_PowerPSoC\)
❐ Kit default firmware hex files (located at CD Drive:\Firmware\Hex Files\) 

■ Quick Start Guide Booklet
■ PSoC Software Development Suite CD

❐ PSoC Designer 5.0 Setup
❐ PSoC Programmer 3.0

1.3 Kit Features
■ Out-of-box evaluation experience using the PowerPSoC Main Board, RGBA LED daughter card 

and Intelligent Lighting Control GUI, all included in the kit.
■ Kit default firmware demonstrates HB-LED control with intelligent color mixing using PowerPSoC.
■ PC USB connectivity through on-board USB controller
■ Screw terminals for flexible input voltage options (7V to 32V)
■ Debug capability provided by the PowerPSoC On Chip Debugger (OCD) device and RJ-45 jack 

that connects to CY3215DK ICE Cube Emulation Kit.
■ Interface to custom LED daughter boards through screw terminals from the PowerPSoC mother 

board
■ CY3271 FirstTouch RF Kit Connector
■ CyFi Radio Module Connector
■ Access to all Function I/O pins of PowerPSoC for additional design and debug capability.

While the Main Board provides connectors for CY3271 FirstTouch RF Kit and the CyFi Radio Mod-
ule, these are not enabled in the kit default firmware. You can also develop firmware to add a
DMX512 or DALI interface to PowerPSoC and use the 5-pin header J12 to connect to a suitable
external interface circuit.

1.4 Precautions

1.4.1 General Safety Precautions
1. Keep your work area clean. Ensure that there are no loose wires or metal pieces lying on the 

table or nearby high-power circuits.
2. Always wear safety glasses when working with circuits at high power or high voltage.
3. Use rubber floor mats to insulate you from ground.
4. Be aware of bracelets, rings, metal watch bands and loose necklace/pendants that you may be 

wearing. They conduct electricity and can cause burns. Do not wear them near an energized cir-
cuit.

5. Be aware of the locations of fire extinguishers and first aid kits in the lab and around your work 
area.
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6. Use only isolated power supplies (either isolated or AC power through isolation power transform-
ers). 

7. Before applying power to your circuit, verify that all connections are correct as per the board 
schematic. Ensure that there are no shorts or ground loops that may lead to electrical shocks or 
damage the test equipment. 

1.4.2 Precautions when working with PowerPSoC based high-power circuits
1. When building your own system with the CY3267 for the first time, begin with low current settings 

(preferably 50mA). Set the DAC thresholds in the PowerPSoC's hysteretic controller accordingly. 
After the system functions as desired at this current setting, increase the hysteretic controller's 
DAC thresholds in steady increments to the final value. At each increment, verify that the compo-
nents on the board are not excessively hot.  

2. Ensure that the high-side DAC reference and the low-side DAC reference differ by a count of at 
least four. For example, if the low-side DAC reference is set to 85 (decimal representation), the 
high-side DAC reference should be set to at least 89.

3. Follow the FET Turn-On sequence suggested in the example project. Altering this sequence may 
damage the PowerPSoC's internal FETs.

1.5 Install Software

1.5.1 Install CY3267 Kit Software
1. Insert the CY3267 PowerPSoC Lighting Evaluation Kit into your PC's CD ROM drive.
2. Locate the Software folder and launch Intelligent Lighting Control.msi file located inside it.
3. Follow the setup wizard instructions

1.5.2 Install latest version of PSoC Designer 5.0
Locate the PSoC Software Development Suite CD included along with the kit. This CD contains
the install files for PSoC Designer 5.0 and PSoC Programmer 3.0.

Launch the setup file for PSoC Designer 5.0 and follow the wizard instructions to complete the instal-
lation.

Note that the software development environment for PowerPSoC family of devices is not available in
PSoC Designer 4.4 or earlier versions. If you have one of these versions installed on your PC, unin-
stall them and install the latest build of PSoC Designer 5.0.

1.5.3 Install latest version of PSoC Programmer
Locate the PSoC Software Development Suite CD included along with the kit. This CD contains
the install files for PSoC Designer 5.0 and PSoC Programmer 3.0.

Launch the setup file for PSoC Programmer 3.0 and follow the wizard instructions to complete the
installation.

If PSoC Programmer is already installed on your PC, use the following instructions to update to the
latest version.
1. Launch PSoC Programmer
2. Select Help > About PSoC Programmer
3. Note the version number and click OK
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4. Click Check for Updates. PSoC Programmer launches your web browser and opens the PSoC 
Programmer website. 

5. Compare the PSoC Programmer version number you noted in Step 3, to the latest version avail-
able on the website. If there is a newer version available, click Download and install the newest 
version.

Note that the PowerPSoC family of devices require PSoC Programmer 3.0 or higher. 

1.5.4 Install PSoC MiniProg1
1. Ensure that all content on the PSoC Software Development Suite CD is installed.
2. Plug the MiniProg1 into your PC via the USB Cable. If this is the first time you have connected 

the PSoC MiniProg1, the Windows Found New Hardware Wizard opens. If this Wizard does not 
open, then the PSoC MiniProg1 software is already installed and you do not need to continue 
with these instructions.

3. Select No, not this time option button and click Next.
4. Select Install from a list or specific location (Advanced) option button and click Next.
5. Select Don't search. I will choose the driver to install option button and click Next.
6. Select USB Mini Programmer driver and click Next.
7. When prompted that the USB Mini Programmer software has not passed Windows Logo Testing, 

click Continue Anyway.
8. When Windows has completed the installation, click Finish.

1.6 Document Revision History 

1.7 Documentation Conventions 

Table 1-1.  Revision History

Revision
PDF 

Creation 
Date

Origin 
of 

Change
Description of Change

** 01/23/09  QUS New Guide

Table 1-2.  Document Conventions for Guides

Convention Usage

Courier New
Displays file locations, user entered text, and source code:
C:\...cd\icc\

Italics Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold] Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open Represents menu paths:
File > Open > New Project

Bold Displays commands, menu paths, and icon names in procedures:
Click the File icon and then click Open.

Times New Roman Displays an equation:
2 + 2 = 4

Text in gray boxes Describes Cautions or unique functionality of the product.
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2. Firmware

The CY3267 PowerPSoC Lighting Evaluation Kit ships with factory installed firmware that demon-
strates the ability of PowerPSoC to drive multiple LED channels with color-mixing intelligence. The
firmware also illustrates the use of PSoC Designer 5.0 to design PowerPSoC based systems and
solutions.

The factory installed example project implements the following elements with PowerPSoC:
■ I2C interface to receive the desired color coordinates and intensity information
■ 4-channel LED dimming using PrISM™ technology
■ Hysteretic current control, with switching current thresholds configured by DAC settings

The CY3267 provides an USB interface to a PC-based Intelligent Lighting Control GUI that enables
users to select the desired color coordinate and intensity from the 1931 CIE Chart. The USB inter-
face is implemented in CY8C24894, which communicates this data over I2C to the PowerPSoC.

The user selects the desired color using the Intelligent Lighting Control GUI or using the Capsense
buttons on the Main Board. These inputs are captured by the firmware in CY8C29894 and transmit-
ted to the PowerPSoC over an I2C interface. The PowerPSoC firmware receives the target color
coordinates and calculates the intensities of each of the four individual colors (Red, Green, Blue, and
Amber) using an intelligent color mixing algorithm. The PowerPSoC also implements the hysteretic
current control loop along with dimming control to drive the LED.  

The PSoC Designer source project for the PowerPSoC default firmware is located in the Lighting
Evaluation Kit CD that accompanies this kit. Use the following path as reference:

CD Drive:\Firmware\CY3267_PowerPSoC

Locate and open the file named CY3267_PowerPSoC.app. This launches the source project in
PSoC Designer 5.0. Ensure that you have installed PSoC Designer 5.0 (available in the PSoC Soft-
ware Development Suite CD) as per instructions in section Install latest version of PSoC Designer
5.0 on page 7.

WARNING: HIGH BRIGHTNESS LEDs CAN CAUSE PERMANENT
EYE DAMAGE!
Do not look at the LEDs if they are not covered by the optical diffuser.
The LEDs illuminate at a very high intensity and can cause
permanent eye damage if they are viewed without the optical diffuser.

WARNING: Generally all lab work in power electronics must be done
with extreme care. Caution must be exercised when using power
supplies and/or power related equipment.
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3. Software

The Intelligent Lighting Control application controls the CY3267 PowerPSoC Lighting Evaluation Kit
over USB interface from a personal computer that is running either the Windows Vista (32-bit) or
Windows XP (32-bit) operating system. The application's startup display, with a board attached and
operating is shown in the following figure.

Figure 3-1.  Intelligent Lighting Control - CIE Color Selection

WARNING: HIGH BRIGHTNESS LEDs CAN CAUSE PERMANENT
EYE DAMAGE!
Do not look at the LEDs if they are not covered by the optical diffuser.
The LEDs illuminate at a very high intensity and can cause
permanent eye damage if they are viewed without the optical diffuser.

WARNING: Generally all lab work in power electronics must be done
with extreme care. Caution must be exercised when using power
supplies and/or power related equipment.
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3.1 Installation

3.1.1 Installation Requirements
To use the application included with the CY3267 PowerPSoC Lighting Evaluation Kit, a personal
computer running Windows Vista or Windows XP is required. The application runs under 32-bit XP
or 32-bit Vista. The computer must have the minimum amount of memory required to run the desired
version of Windows, and at least one megabyte of available disk storage. In addition, one available
USB port is needed to connect the evaluation unit to the computer, using an A to mini-B USB cable.

3.1.2 Installing the Application
The Intelligent Lighting Control application is included on the kit CD. To install the application, do the
following:
1. Open the CD Drive:\Software folder and click Intelligent Lighting Control.msi file. The application, 

along with a required .dll file (and .NET Framework 2.0, if it is not already installed), installs.
2. The Intelligent Lighting Control application and associated .dll file installs into the location   

C:\Program Files\Cypress\Intelligent Lighting Control on your computer's default disk, usually 
drive C.

3.1.3 Uninstalling the Application
To uninstall the application, do the following:
1. Run the Install program again and click Remove Intelligent Lighting Control button.
2. Click Finish button at the bottom right of the setup window. 

3.2 Representing Colors
The application has two modes of control: a CIE Color Selection Mode and Direct LED Control
Mode. These two modes are selected using tabs displayed on the upper left edge of the application
window. The CIE Color Selection Mode is the active display when the application is started and is
intended to be the most common mode used to control the CY3267. The colors that can be mixed
are determined by the choice of LEDs used in the unit. The colors produced by individual LEDs are
referred to as primary colors. All other colors are created by mixing these primary colors. Mixed col-
ors appear the same to the eye as if produced by an LED with that color as its primary color. The
interior portion of the polygon displayed on the color chart represents the range of colors that can be
mixed by the LEDs in the unit. The range of colors that can be mixed when using a given set of pri-
mary LEDs is called the color gamut for those LEDs. Once the primary LED colors are determined,
as they are in the evaluation unit, the color gamut is defined by those choices. Thus, the polygon dis-
played by the application defines the color gamut for the unit. Colors outside the color gamut cannot
be represented by the given LEDs and thus cannot be selected by the user.

The CIE Color Mix Mode displays the 1931 CIE Color chart. This chart represents the range of col-
ors visible to the human eye. Clicking anywhere within the color gamut polygon places a dot at the
selected point. The corresponding CIE coordinates for that color coordinate are transmitted to the
CY3267 Main Board, where the selected color is displayed by adjusting the four LEDs to brightness
levels that create the specified mixed color. The resulting coordinates are displayed in the CIE Coor-
dinates panel on the upper right portion of the display. The CIE 1931 x, y coordinates are displayed
in the upper two coordinate fields and the u', v' coordinates are displayed in the lower two fields. An
alternative to selecting a color by clicking in the color chart is to enter coordinates into these fields.
The user can enter a color point in x, y coordinates, u', v' coordinates, or any combination of the two
coordinate systems.
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Figure 3-2.  CIE Coordinates

The Direct LED Control Mode is an alternative to specifying colors using CIE coordinates. This mode
displays four slider controls, one for each LED on the LED daughter card. Moving a slider from bot-
tom to top causes the corresponding LED to light from zero to one-hundred percent of its maximum
rated flux. When the direct LED control mode is enabled, all controls that relate to mixing colors are
disabled, including the Requested Luminous Flux slider that sets the total flux of a given mixed color:
these controls have no meaning when setting the individual LED flux levels manually.

Figure 3-3.  Intelligent Lighting Control - Direct LED Control

The application can also limit color choices to those that are produced by a black body radiator. A
black body radiator is a theoretical, color-neutral object defined by Planck’s Law. A black body radia-
tor glows (radiates energy) at different colors as it is heated. When enabled, the black body curve is
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displayed on the CIE color chart. This curve marks the colors that correspond to the color of a black
body radiator over a range of temperatures in Kelvin. The user selects the color temperature value
by sliding the color temperature slider.

Color temperature (more generally, correlated color temperature) is a common way that the color of
light in the white region is specified. Disabling the color temperature control removes the black body
curve from the color chart, disables the color temperature slider, and enables the controls used to
specify mixed colors using the CIE color chart.

Figure 3-4.   CIE Color Selection Tab - Color Temperature Control

In addition to displaying colors, the application allows the user to turn the LEDs On or Off. The state
of the LEDs (On or Off) is based on a closed loop between the application and the CY3267 Main
Board that determines the actual on/off state of the LEDs. The On/Off buttons are displayed on the
bottom right portion of the application's window. When the LEDs are off, the LEDs On button is
enabled. Clicking on this button turns the LEDs on. If the LEDs are on, the Off button is enabled and
clicking on this button turns the LEDs off. Regardless of the setting when the application is not con-
nected to a board, the buttons change to show the actual state of the LEDs when the board is
attached.

Figure 3-5.  LEDs ON/OFF Control

Below the tabbed window is a status window, which shows the current status of the connection
between the application and the CY3267 Main Board, and any error messages. If an error or change
of status occurs, a message appears describing the event. The message "I2C Bridge device found -
Version 1.0" is displayed in the status window. The message appears for approximately five seconds
and is then cleared from the status window.

3.3 LED Luminous Flux
The luminous flux of the mixed color output can be varied using the Requested Luminous Flux slider
located on the right side of the application window. The maximum total flux produced by the LEDs
varies, depending upon the chosen color. For example, a neutral white can be set to a higher total
flux than any of the four primary colors alone, as the color white is represented by a sum of the light
output of each of the LEDs. The saturation point (the point of maximum total flux) differs for different
colors. Moving the slider to a requested flux higher than the saturation point for a given color has no
effect upon the light output of the LEDs as they remain at that mixed color's saturation point. Note
that this slider determines the requested luminous flux. This requested value is usually derated by
the color mixing firmware on the CY3267 Main Board. This is required to perform temperature com-
pensation, keeping the requested color as accurate as possible.
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Figure 3-6.  Luminous Flux 

 



16 CY3267 PowerPSoC Lighting Evaluation Kit Guide, Spec. # 001-49266 Rev. **

Software



CY3267 PowerPSoC Lighting Evaluation Kit Guide, Spec. # 001-49266 Rev. ** 17

4. Hardware

4.1 Board Specification

4.1.1 Main Board

Figure 4-1 on page 18 shows a labeled diagram of the CY3267 Main Board with all the key compo-
nents marked. The board provides options for interfacing the Artaflex™ WirelessUSB Radio module,
FirstTouch RF Interface, 5V and a Thermistor interface for the LED daughter card. However, the kit’s
default firmware does not provide support for these interfaces.

WARNING: HIGH BRIGHTNESS LEDs CAN CAUSE PERMANENT
EYE DAMAGE!
Do not look at the LEDs if they are not covered by the optical diffuser.
The LEDs illuminate at a very high intensity and can cause
permanent eye damage if they are viewed without the optical diffuser.

WARNING: Generally all lab work in power electronics must be done
with extreme care. Caution must be exercised when using power
supplies and/or power related equipment.

Feature Description
Main Board Power Source (Wall-wart) 12V DC, 2A

Main Board Power Source (External power supply 
through screw terminals J2) 32V DC, 4A

Maximum Power Consumption 128 W (32V*4A)

Board Size 4.75 x 5 x 0.063 inches (121 x 127 x 1.62 mm)

Layer Count 4 layers (TOP, GND, HV_VCC, BOTTOM)
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Figure 4-1.  CY3267 PowerPSoC Lighting Evaluation Kit Main Board

4.1.2 LED Daughter Board

Feature Description
Power Source 5V (via J15)

Maximum Power Consumption 5V, 1mA (5mW)

Board Size 3.15 x 3.15 x 0.063 inches (80 x 80 x 1.62 mm)

Layer Count 2 layers (TOP, BOTTOM)
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Figure 4-2.  CY3267 LED Daughter Board

4.2 Jumper Settings and Connector Descriptions

Power Nets
The board has several power nets. The definitions of the different power nets follows.
■ HV_VDD (7V-32V) - This is the input power before it is fed to any of the regulators.
■ VDD (5V) - Power provided to the PSoC devices.
■ VREG (5V) - This is fed by HV_VDD and is the output of the onboard 5V regulator.
■ VAUX (5V) - This is fed by HV_VDD and is the output of the PSoC auxiliary 5V regulator.
■ VBUS (5V) - Power derived from the USB interface via a USB host.
■ 3.3V - This is fed by the onboard 5V regulator (VREG).
■ HV_GND - Ground reference for high voltage HV_VDD net.
■ D_GND - Ground reference for digital 5V net.

J1 - DC Power Jack

Use a 12V/2A wall wart power supply when powering from the barrel power jack. This input power is
HV_VDD. The barrel power jack is equipped with an internal switch which, when a wall wart power
supply is plugged in, disengages the J2 ground terminal, preventing the board from being overpow-
ered by more than one power supply.

LED Module

Main Board 
Interface

Temperature 
Sensor

+ 

         DC +12V/2A 
-
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J2 - Screw Terminal Power Block
This terminal block provides the user with ability to power the main board with a bench power supply.
The terminal block supports 7V-32V at up to 4A. A wall wart power supply should not be used if
power is being supplied to the board through the J2 terminal block.

J3 - PSoC Power
This header allows the user to select the 5V source from either the onboard regulator (VREG), the
PSoC auxiliary regulator (VAUX), or from the USB 5V rail (VBUS).

J9 - Artaflex Wireless Radio Module Power
Header J9 must be jumpered in order to use the Artaflex wireless radio module. Placing a jumper on
J9 provides 3.3V power to the radio module. 

J13, J14 - I2C Clock and Data Pull Ups
Headers J13 and J14 are provided for expandability of the system to support external daughter
cards with I2C capable interfaces.  DALI and DMX512 daughter cards are examples of expandable
cards which could be used with this board.  Programming header J12 doubles as both a program-
ming header for the CY8CLED04DOCD device and an I2C interface to the CY8CLED04DOCD
device.  Placing shunts on J13 and J14 to pull up the I2C clock and data lines would be necessary if
these types of daughter cards are used.  Otherwise, these two headers should remain un-shunted.

J6, J7, J10, J11 - LED Daughter Card Connectors
These 4 terminal blocks provide the LED power interface between the main board and the LED
daughter card. The terminal blocks are labeled as "BCK or BST" and "BCK-BST". If the board is con-
figured for buck or boost operation, the LED daughter card should be wired with the "+" wire (LED
cathode) connected to the center terminal and the "-" wire (LED anode) connected to the terminal
labeled "BCK or BST". If the board is configured for buck-boost operation, the LED daughter card
should be wired with the "+" wire connected to the center terminal and the "-" wire connected to the
terminal labeled "BCK-BST".

J15 - LED Daughter Card Thermistor
This terminal block provides an interface for I2C communication between the main board and the
LED daughter card. Terminals are clearly labeled and can be wired one-to-one with the LED board
using the VCC, GND, DATA, and CLK wires.

P4 - Unused GPIO
Receptacle P4 provides access to the unused GPIO of the PowerPSoC device.

P1 - RJ45 ICE Cube Emulation Connector
This RJ45 receptacle provides a debug interface between the CY8CLED04DOCD device and the
ICE Cube emulation tool using the PSoC Designer software application.

P2 - Artaflex Radio Module Connector
This 12-pin connector provides an interface to the Artaflex radio module. The module is powered by
a 3.3V source and communicates with the PSoC device via the I2C protocol.

P3 - FirstTouch RF Radio Module Connector
This 16-pin connector provides an interface to the CY3271 FirstTouch radio module. The module is
powered by a 3.3V source and communicates with the CY8C24894 device via the I2C protocol. 
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J8 - Full Speed USB Port
The board has a mini-B full speed USB connector. There are also two test points for the differential
pair signals D- and D+. The power net VBUS is brought into the board through this interface. 

CapSense Elements
The main board has two capacitive sensing elements connected directly to the CY8C24894 PSoC
device. If the default firmware provided is used, the button on the left switches the LEDs on and off
while the button on the right cycles through various color combinations displayed on the LED daugh-
ter card.

4.3 Floating Load Buck Topology
The CY3267 Main Board is populated with components for the floating-load buck topology. The float-
ing load buck topology consists of two ceramic input bypass capacitors (0.1uF and 1.0uF) each rated
for 50V in 0603 package size. These are low ESR type capacitors.  Current flow through the LED is
sensed by the PowerPSoC device using a 0.1 ohm sense resistor (R2 below). Not pictured is the
LED itself, but is attached to the terminal block (J6 below) with the anode side connected to the cen-
ter pin 2 labeled with a "+" sign. The cathode side of the LED is connected to pin 3 of the terminal
block labeled "-" or "BCK or BST". The inductor is rated for 1.41A so as to handle high peak currents.
Diode selection also takes into account the peak current that the diode could see, given the size of
the inductor and the ripple current. The diode is a 40V, 2.2A rated Schottky type diode. Also included
in the circuit is a v zener diode connected to the PSoC FET drain so as to protect the drain voltage
from climbing above 36V.  

Note:  The terminal block pins 1 and 3 for J10 and J11 are swapped from that of J6 and J7. Ensure
that the cathode side (negative terminal of LED) is connected to the pin labeled "BCK or BST" on the
CY3267 Main Board.

Figure 4-3.  Floating Load Buck Topology, Single Channel
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4.3.1 Board Wiring Instructions
The main board is equipped with five screw-terminal blocks used to connect the LED and main
board together. The 4-post terminal block (J15) is used as the I2C interface between the PowerP-
SoC device and the thermistor on the LED board. This terminal block contains the following signals:

Table 4-1.  Signals

The other four terminal blocks are used to connect the multi-color LED module to the main board.
These are J6 (RED channel), J7 (BLUE channel), J10 (AMBER channel) and J11 (GREEN channel).
The LED daughter card has two wires connected to each color of the module. One wire is connected
to the anode side of the LED while the other wire is connected to the cathode side of the LED. Each
of these terminal blocks has two possible wiring schemes associated with them. The default scheme
is the Buck or Boost scheme. The other scheme is the Buck-Boost scheme. The following matrix
shows these schemes with wire colors and the posts they connect to.  

Note: To prevent damage to the LED and PowerPSoC, ensure that the boards are wired according
to Figure 4-4.

Signal Wire Color

VDD (5V) RED

TEMP_DATA TAN

TEMP_CLK GREEN

GND (GROUND) BLACK
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Figure 4-4.  Main Board Wiring Scheme
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